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1  About this document

1.1  Document function
This manual should support during the configuration of Tankvision Professional NXA85. It
deals with the setup of the Movements package.

1.2  Target audience
Beside basic PC operating knowledge no special training is needed to perform the
Tankvision Professional System operations. Nevertheless it is recommended receiving a
training on the system by Endress+Hauser.

1.3  Software versions and certification
Due to the certification process with weights and measures agencies, the latest
software version might only be certified at a later stage. Also some features might be
incompatible with the weights and measures regulations and can therefore not be
combined.

1.4  Symbols

1.4.1  Safety symbols
DANGER

This symbol alerts you to a dangerous situation. Failure to avoid this situation will result in
serious or fatal injury.

WARNING

This symbol alerts you to a potentially dangerous situation. Failure to avoid this situation
can result in serious or fatal injury.

CAUTION

This symbol alerts you to a potentially dangerous situation. Failure to avoid this situation
can result in minor or medium injury.

NOTICE

This symbol alerts you to a potentially harmful situation. Failure to avoid this situation can
result in damage to the product or something in its vicinity.

1.4.2  Symbols for certain types of information
 Tip

Indicates additional information

Reference to documentation

Notice or individual step to be observed

1. , 2. , 3.

Series of steps

Result of a step



Tankvision Professional NXA85 About this document

Endress+Hauser 5

1.4.3  Symbols in graphics
1, 2, 3, ...
Item numbers

1. , 2. , 3.

Series of steps

A, B, C, ...
Views

1.4.4  List of abbreviations
• ETF

Estimated time to finish
• GOV

Gross Observed Volume
• GSV

Gross Standard Volume
• TOV

Total Observed Volume

1.5  Documentation
For an overview of the scope of the associated Technical Documentation, refer to the
following:
• Device Viewer (www.endress.com/deviceviewer): Enter the serial number from the

nameplate
• Endress+Hauser Operations app: Enter serial number from nameplate or scan

matrix code on nameplate.

The following document types are available in the Downloads area of the Endress+Hauser
website (www.endress.com/downloads), depending on the device version:

Document type Purpose and content of the document

Technical Information (TI) Planning aid for your device
The document contains all the technical data on the device and provides
an overview of the accessories and other products that can be ordered for
the device.

Brief Operating Instructions (KA) Guide that takes you quickly to the 1st measured value
The Brief Operating Instructions contain all the essential information
from incoming acceptance to initial commissioning.

Operating Instructions (BA) Your reference document
The Operating Instructions contain all the information that is required in
various phases of the life cycle of the device: from product identification,
incoming acceptance and storage, to mounting, connection, operation
and commissioning through to troubleshooting, maintenance and
disposal.

Description of Device Parameters
(GP)

Reference for your parameters
The document provides a detailed explanation of each individual
parameter. The description is aimed at those who work with the device
over the entire life cycle and perform specific configurations.

Safety instructions (XA) Depending on the approval, safety instructions for electrical equipment in
hazardous areas are also supplied with the device. These are an integral
part of the Operating Instructions.

 The nameplate indicates which Safety Instructions (XA) apply to
the device.

Supplementary device-dependent
documentation (SD/FY)

Always comply strictly with the instructions in the relevant
supplementary documentation. The supplementary documentation is a
constituent part of the device documentation.

https://www.endress.com/deviceviewer
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1.6  Change history
BA00394G_13.10
• 18.0.0
• Initial version

BA00394G_14.14
• 18.0.2 and 18.0.3
• New layout; Enhanced Product, Tank and Movement functionality

BA00394G_15.16
• 18.0.2 and 18.0.3
• New features

BA00394G_16.17
• 18.1.1
• Unification of the W&M and the non W&M software packages.

BA00394G_17.25-00
• 18.1.1
• Minor changes
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2  Basic safety instructions

2.1  Requirements for the personnel
The personnel for installation, commissioning, diagnostics and maintenance must fulfill
the following requirements:
‣ Trained, qualified specialists must have a relevant qualification for this specific function

and task.
‣ Are authorized by the plant owner/operator.
‣ Are familiar with federal/national regulations.
‣ Before starting work, read and understand the instructions in the manual and

supplementary documentation as well as the certificates (depending on the
application).

‣ Follow instructions and comply with basic conditions.

The operating personnel must fulfill the following requirements:
‣ Are instructed and authorized according to the requirements of the task by the facility's

owner-operator.
‣ Follow the instructions in this manual.

2.2  Intended use

2.2.1  Intended use of Tankvision Professional NXA85 software
Tankvision Professional is specifically designed for operators of bulk storage facilities,
marketing terminals, refineries and pipelines. It is designed to handle all the data
acquisition, supervisory control and monitoring required in a single fully integrated
solution.

Tankvision Professional integrates all major types of tank measurement instruments into
one system.

All measured and calculated tank parameters are accessible to your tank farm and
terminal operators as well as to connected host systems.

Multi-user operation is provided by the inbuilt Web Server offering the opportunity to
access data at any connected location (local/remote) e.g. for administrative and accounting
purposes.

2.3  IT security
The manufacturer warranty is valid only if the product is installed and used as described in
the Operating Instructions. The product is equipped with security mechanisms to protect it
against any inadvertent changes to the settings.

IT security measures, which provide additional protection for the product and associated
data transfer, must be implemented by the operators themselves in line with their security
standards.



Incoming acceptance and product identification Tankvision Professional NXA85

8 Endress+Hauser

3  Incoming acceptance and product
identification

3.1  Incoming acceptance
On receipt of the delivery:

1. Check the packaging for damage.
 Report all damage immediately to the manufacturer.

Do not install damaged components.

2. Check the scope of delivery using the delivery note.

3. Compare the data on the nameplate with the order specifications on the delivery
note.

4. Check the technical documentation and all other necessary documents, e.g.
certificates, to ensure they are complete.

If one of the conditions is not satisfied, contact the manufacturer.

3.2  Product identification
The following options are available for identification of the software:

• Nameplate specifications
• Order code with breakdown of the software features on the delivery note
• Enter serial numbers from nameplates in Device Viewer

(www.endress.com/deviceviewer): All information about the software is displayed.

For an overview of the technical documentation provided, enter the serial number from
the nameplate in the Device Viewer (www.endress.com/deviceviewer).

3.2.1  Nameplate
The information that is required by law and is relevant to the product is shown on the
nameplate, e.g.:
• Manufacturer identification
• Product name
• Order code
• Extended order code
• Serial number
• Barcode

3.2.2  Manufacturer address

Endress+Hauser SE+Co. KG
Hauptstraße 1
79689 Maulburg, Germany
Place of manufacture: See nameplate.

3.2.3  Order code and product version
To find out the version of your software, enter the order code indicated on the
nameplate in the search screen at the following address:
www.products.endress.com/order-ident



Tankvision Professional NXA85 Movements Configuration Introduction

Endress+Hauser 9

4  Movements Configuration Introduction
The movements system within the tank gauging software is used to plan, open, suspend
and close movements.

‣ To open the Movements Summary screen in Tankvision Professional click View →
Movements.

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5  System Settings
The System Settings screen is accessed from the Movements Summary screen by
selecting the System Settings entry from the Configuration menu.

5.1  General Settings

5.1.1  Show details for each movement in a new window
If this box is ticked, a new window is opened every time a request to view a movement’s
details is made. Otherwise, only one details window is created and only details of the last
selected movement are displayed.

5.1.2  Monitor Movements By
When viewing a movement in the detail window, this option dictates what quantity will be
used to display the progress of the movement. Most of the options are self-evident, the
Movement Target Type changes the selected monitoring quantity based on how the
movement was configured.

The options are:
• Movement Target Type
• GOV
• TOV
• GSV
• Weight
• Mass
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5.1.3  Tank Contents Colour
This drop-down list allows configuration of the way that tank graphics are to be displayed
on the details window:
• Use System Settings - Use the flag from the Tankvision Professional system settings
• Use Product Colour - Use the colour defined for the product that the tank contains
• Use Flow Colour - Use Blue if the tank level is going up, Brown if the tank level is going

down, or Green if the tank is static

5.1.4  Alarm Set Points Override
This drop-down list allows configuration of the way that the default alarm set points are
overridden:
• Tank - Alarm set points can be overridden for individual tanks
• Movement Class - Alarm set points can be overridden for different movement classes

5.2  Archive
If this box is ticked, movements will be automatically deleted from the system after the
entered number of days.

5.3  New Movements
The settings in this section affect the New Movement Wizard.

• Default Product - The product that is initially selected on the Movement Details page
of the New Movement Wizard

• Quick Transfer Class - The movement class that movements configured using the quick
transfer screen are given

• Default Movement Target Type - The default quantity type used to plan movements
• Include Notes Page - If set, the user will be presented with the opportunity to enter

some notes on the movement during the creation process
• Include timed activities - If set, the user will be prompted to add timed activities to the

movement during the creation process.

Note the default movement target type must be selected as one of the movement
target types to be offered to users.

Note that these setting only affect movements created after the settings are changed,
not ones already created.

5.4  Operation
The operation settings are an expandable group that is initially contracted when the
window opens.

‣ Expand the group to access the settings.

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If the:
• Enter manual data for subject tank when changing status box is ticked - The user will

be shown a screen allowing the manual data figures for the associated tanks to be
entered when opening, suspending, reopening or closing movement subjects.

• Amend planned quantity for subject when opening box is ticked - The user will be
shown a screen allowing the planned quantities to be amended when opening or
reopening movement subjects.

If the planned quantity would take the tank associated with the movement subject
above the maximum operating level or below the minimum operating level, the screen
will be displayed anyway.

• Enter manual data for movement tank when changing status box is ticked - The user
will be shown a screen allowing the manual data figures for the associated tanks to be
entered when opening, suspending, reopening or closing movement tanks.

• Amend planned quantity for movement tank when opening box is ticked -The user
will be shown a screen allowing the planned quantities to be amended when opening or
reopening movement tanks.

If the planned quantity would take the tank associated with the movement subject
above the maximum operating level or below the minimum operating level, the screen
will be displayed anyway.

• Enter manual data for tank when changing status of timed activity box is ticked -The
user will be shown a screen allowing the manual data figures for the associated tanks to
be entered when opening, suspending, reopening or closing timed activities.

• Amend planned time for activity when opening box is ticked - The user will be shown
a screen allowing the planned time to be amended when opening or reopening timed
activities.

• Suspend and reopen all open movements at {0} box is ticked - All open movements
will be automatically suspended and reopened at the entered time. The normal use for
this is to allow the inventory figures to be broken down into figures for each day the
movement is open by suspending and reopening all open movements at midnight.

When you close the movement, the screen to set the manual data for the tank will be
presented, there is a calculator button on the reference density entry box.

1. Click the calculator button.
 This will offer you the movement density calculation screen.

2. Enter an observed density for the movement cargo and the average density is
returned from the calculation screen to the manual data screen.

3. Close the manual data screen to finish the movement and the manual density value
for the tank is updated.

5.5  Movement Target Types
The movement target types are an expandable group that is initially contracted when the
dialogue opens.

1. Expand the group to access the settings.

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2. Tick the movement target types that you wish operators to use when configuring
movements and transfers. You must select the movement target type that matches
your choice of default movement target type.

These settings just control the target types offered during the configuration of movements
and transfers, they do not:
• Limit the choice of fill, empty or strip, which have implied movement target types

associated with their use
• Alter the chosen movement target types of previously configured movements
• Cause "absolute" types to appear in situations where their use is precluded
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6  Alarm Defaults
The Default Alarm Configuration screen is accessed from the Movements Summary
screen by selecting the Alarm Defaults entry from the Configuration menu.

This screen is used for entering the default values for alarms. Once a movement has been
created, the alarm settings for that movement can be amended using the Edit Alarm
Configuration option.

See the Movements System Operation manual BA00395G for more details.

6.1  Movement Alarms
The settings in this section are used to configure the alarms for a complete movement.

• If the Raise alarm when the total net flow for the movement exceeds box is ticked, an
alarm will be raised for the movements when the total flow for all open receipt tanks on
the movement is difference from the total flow for all open load tanks on the movement
by more than the entered amount.

• If the Reraise active flow alarms every {0} minutes box is ticked, active low flow
alarms and reverse flow alarms will be raised at the entered time period.
If this box is not ticked, low flow alarms are automatically reset when the flow from the
tank rises above the entered threshold and will be reraised when the flow from the tank
next drops below the threshold. Similarly reverse flow alarms are automatically reset
when the flow from the tank drops below the entered threshold and are reraised when
the flow from the tank rises above the threshold.

• The Raise low flow alarms for drop-down list allows configuration of the direction for
which low flow alarms are to be raised.

6.2  Tank Alarms
Default values for tank alarms can be set on a global basis, but can also be overridden for
specific tanks or movement classes, see option System Settings.
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1. A new set of overrides can be added by clicking on the Add button.
 This will cause a new screen to be displayed allowing selection of the tank for

which overrides are to be set:

The tank or movement class for which overrides are to be set should be selected
from the drop-down list.

2. Click the OK button to add the new set of overrides to the list.

Similarly a set of overrides can be removed by selecting the override in the list and then
clicking the Remove button.

The individual settings have the following effect:
• If the First time to target alarm box is ticked an alarm will be raised for a movement

tank when the estimated time to finish for that tank falls below the entered value. By
default this is an alarm of low severity.

• If the Second time to target alarm box is ticked an alarm will be raised for a movement
tank when the estimated time to finish for that tank falls below the entered value. By
default this is an alarm of high severity.

• The Hysteresis for time to target alarms field controls when the time to target alarms
are reset. If an anomaly in the flow rate causes the time to target alarms to be raised
prematurely by causing an incorrect calculation of the estimated time to finish, they will
be reset when the estimated time to finish exceeds the entered threshold by the
hysteresis amount.

• If the First approaching target alarm box is ticked an alarm will be raised when the
product level in the tank differs from the target level by less than the entered value. By
default this is an alarm of low severity.

• If the Second approaching target alarm box is ticked an alarm will be raised when the
product level in the tank differs from the target level by less than the entered value. By
default this is an alarm of high severity.

• If the Raise alarm when target level is achieved box is ticked an alarm will be raised
when the product level in the tank reaches the target level. By default this is an alarm of
high severity.

• If the Target level exceeded alarm box is ticked an alarm will be raised when the
product level in the tank exceeds the target level by the entered value. By default this is
an alarm of critical severity.

• The Hysteresis for target level alarms box controls when the target level alarms are
reset. If an anomaly in the product level reading causes the target level alarms to be
raised prematurely, they will be reset when the difference between the product level and
target level exceeds the entered value for that alarm plus the hysteresis value.
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• If the Low flow alarm box is ticked an alarm will be raised if the flow rate for the tank
falls below the entered threshold, unless the movement tank has been open for less than
the entered time.
• If the Reraise active flow alarms box is ticked (see "Movement Alarms") this alarm

will be reraised at the specified time interval for as long as the flow rate for the tank
remains below the entered threshold.

• If the Reraise active flow alarms box is not ticked, the alarm will be raised once when
the flow rate falls below the entered threshold. The alarm will not be reraised unless
the flow rate rises above the entered threshold and then falls below it again.

• If the Reverse flow alarm box is ticked an alarm will be raised if the flow rate for the
tank is in the wrong direction by more than the entered threshold, unless the movement
tank has been open for less than the entered time.
• If the Reraise active flow alarms box is ticked (see "Movement Alarms") this alarm

will be reraised at the specified time interval for as long as the flow rate for the tank
remains above the entered threshold in the wrong direction.

• If the Reraise active flow alarms box is not ticked, the alarm will be raised once when
the flow rate rises above the entered threshold in the wrong direction. The alarm will
not be reraised unless the flow rate falls below the entered threshold in the wrong
direction and then rises above it again.

• If the Disable alarm box is ticked, a reverse flow alarm will not be raised until after the
flow has exceeded the entered flow rate in the correct direction. This is to prevent false
alarms caused by initial flow of product when valves are opened.

6.3  Timed Activity Alarms
Default values for timed activity alarms can be set on a global basis, but can also be
overridden for specific tanks or movement classes and/or timed activities.

1. A new set of overrides can be added by clicking on the Add button.
 This will cause a new screen to be displayed allowing selection of the timed

activity and tank for which overrides are to be set:

The timed activity and tank or movement class for which overrides are to be set
should be selected from the drop-down lists.

2. Click the OK button to add the new set of overrides to the list.

Similarly a set of overrides for a timed activity/tank combination can be removed by
selecting the entry in the list and then clicking the Remove button.



Tankvision Professional NXA85 Alarm Defaults

Endress+Hauser 17

The individual settings have the following effect:
• If the First alarm box is ticked an alarm will be raised for a timed activity when the time

remaining for that activity falls below the entered value. By default this is an alarm of
low severity.

• If the Second alarm box is ticked an alarm will be raised for a timed activity when the
time remaining for that activity falls below the entered value. By default this is an alarm
of high severity.

• If the Raise alarm when activity should be closed box is ticked an alarm will be raised
when the timed activity should be completed (based on the planned time).

• If the Overdue alarm box is ticked an alarm will be raised for a timed activity when the
time the activity has been open exceeds the planned time by more than the entered
amount.
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7  Timed Activities
The Timed Activities screen is accessed from the Movements Summary screen by
selecting the Timed Activities entry from the Configuration menu.

This screen is used for creating, deleting and editing timed activities.

‣ To create a new timed activity, click the Add button.
 A new activity will be added to the list as the currently selected entry. Details of the

new activity can then be edited.

‣ To remove a timed activity, select the activity to be removed in the list of activities and
then click the Remove button.

‣ To edit a timed activity, select the activity to be edited in the list of activities.
 The current values for the activity will be displayed on the right hand part of the

screen and can be edited as required.
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8  Movement Types
The Movement Types screen is accessed from the Movements Summary screen by
selecting the Movement Types entry from the Configuration menu.

This screen is used for editing movement types. There are 4 movement types:
• Receipt
• Load
• Transfer (one to many)
• Transfer (many to one)

1. To edit a movement type, select the movement type from the list of movement types.
 The current values for the movement type will be displayed on the right hand

part of the screen. Although the Description can be edited, the movement type
can still be determined using the Transfer and Receipt fields which are not
editable.

2. To associate a movement class with the currently selected movement type, click the
Add button.
 A list of the currently configured movement classes will be displayed:

3. Select the movement class to be associated with the currently selected movement
type from the list.
 The movement class will then be added to the list of movement classes associated

with the currently selected movement type.

4. To disassociate a movement class from the currently selected movement type, select
the movement class in the list of associated movement classes and click the Remove
button.

5. To edit available movement classes, click the Configure button.
 This will display the Movement Classes screen (see section "Movement Classes").

Movement types cannot be used unless they are associated with a movement class
which has been pre-configured. Failure to do this will lead to erratic behavior within
the movements application.

This is particularly relevant to the simple tank to tank transfer where the movement class
is not shown. It is still imperative that the movement types for transfer (one to many and
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many to one) are associated with a movement class e.g. transfer, or blend or something
similar.
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9  Movement Classes
The Movement Classes screen is accessed from the Movements Summary screen by
selecting the Movement Classes entry from the Configuration menu or by clicking the
Configure button on the Movement Types screen (see section "Movement types").

This screen is used for creating, deleting and editing movement classes.

Creating a movement class

‣ To create a new movement class, click the Add button under the list of existing
movement classes.
 A new movement class will be added to the list as the currently selected entry.

Details of the new movement class can then be edited.

Deleting a movement class

‣ To remove a movement class, select the movement class to be removed in the list of
movement classes and then click the Remove button under the list of movement
classes.

Editing a movement class

‣ To edit a movement class, select the movement class to be edited in the list of
movement classes.
 The current values for the movement class will be displayed on the right hand part

of the screen and can be edited as required.

Movement Class Parameters
• Description - A description of the movement class
• Custom Data {0} - The caption to be displayed next to the corresponding custom data

field in the movement header
• Image - The text on the button in the image area will be Add if the movement class does

not currently have an image associated with it, or Change if it does.
Clicking this button will display a file selection screen:
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‣ Navigate to the file to be used as the image for the movement class and then click the
Open button.

Image - If the Remove button in the image area is clicked, the image for the movement
class will be removed.
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10  Adjustments
The Movement Adjustments screen is accessed from the Movements Summary screen by
selecting the Adjustments entry from the Configuration menu

This screen is used for creating, deleting and editing adjustments.

Creating an adjustment

‣ To create a new adjustment, click the Add button.
 A new adjustment will be added to the list as the currently selected entry. Details of

the new adjustment can then be edited.

Deleting an adjustment

‣ To remove an adjustment, select the adjustment to be removed in the list of
adjustments and then click the Remove button.

Editing an adjustment

‣ To edit an adjustment, select the adjustment to be edited in the list of adjustments.
 The current values for the adjustment will be displayed on the right hand part of

the screen and can be edited as required.
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11  Pipeline Configuration
The Pipeline Configuration screen is accessed from the Movements Summary screen by
selecting the Pipeline Config entry from the Configuration menu.

This screen is used for creating, deleting and editing pipelines.

Creating a new pipeline

‣ To create a new pipeline, click the Add button.
 A new pipeline will be added to the list as the currently selected entry. Details of

the new pipeline can then be edited.

Removing a pipeline

‣ To remove a pipeline, select the pipeline to be removed in the list of pipelines and then
click the Remove button.

Editing a pipeline

‣ To edit a pipeline, select the pipeline to be edited in the list of pipelines.
 The current values for the pipeline will be displayed on the right hand part of the

screen and can be edited as required.



Tankvision Professional NXA85 Maintain View

Endress+Hauser 25

12  Maintain View
The columns displayed in the summary views and historical view can be changed or
reordered along with the order that the movement records are displayed in.

To modify a view on the summary screen, make sure that the view to be changed is the
view being displayed and then select Maintain View from the Options menu.

To modify the view on the Historical Movements screen, simply select Maintain View
from the Options menu. The following screen will be displayed:

12.1  General
If the Display movement subjects which are not tanks box is ticked then movement
subjects which are not tanks will be displayed in the view.

If the box is not ticked then only movement subjects which are tanks will be displayed in
the view.

12.2  Fields
The fields section contains a list of the fields currently displayed in the view. The fields
that have a gray background are fields that cannot be reordered or removed.
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Adding a new field
1. To add a new field to the list, click the Add button.

 A screen containing a list of available fields will be displayed:

2. Select the field to be added and click the OK button.

Removing a field

‣ To remove a field from the list, select it and then click the Remove button.

Moving a field up and down
1. To move a field up the list (left in the view), select it and click the  button.

2. To move a field down the list (right in the view), select it and click the  button.

Further configurations
For some fields it is possible to configure them further:
If a field is only applicable to a tank (for example Target Level), an alternative field can be
selected for entries that are timed activities:

If a field contains a date/time value, a format can be specified:
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If a field contains a time span value, a format can be specified:

12.3  Sorts
If the Keep components for each movement together box is ticked, the rows for each
movement will be kept together and the entire movement will be sorted according to the
sort criteria.

The sort criteria are set by selecting a field from the drop-down list of fields and then
selecting the order from the corresponding drop-down list. Up to 5 fields can be chosen as
sort criteria.
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13  Security
The access rights for the movements system are set on a user group basis. For the access
rights to be applied to a specific user they must be a member of the given user group. The
access rights are maintained using the Maintain User Groups option from the Security
menu on the Tankvision Professional Home Page.

The access rights relating to the movements system all come under the Movements entry
in the access rights list (see above). To amend the access rights for a user group, select the
relevant user group from the list of user groups and then tick and untick the relevant boxes
in the access rights list.

13.1  Configuration

13.1.1  Settings
• View - This option should be ticked if members of the user group are allowed to view the

System Settings screen (see section "System Settings")
• Edit - This option should be ticked if members of the user group are allowed to edit the

Movement settings

13.1.2  Adjustments
• View - This option should be ticked if members of the user group are allowed to view the

Movement Adjustments screen (see section "Adjustments")
• Edit - This option should be ticked if members of the user group are allowed to edit

Adjustment Details.
• Add - This option should be ticked if members of the user group are allowed to create

new adjustments.
• Remove - This option should be ticked if members of the user group are allowed to

remove adjustments.
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13.1.3  Alarm Defaults
• View Movement Alarms - This option should be ticked if members of the user group

are allowed to view the default movement alarm settings on the Default Alarm
Configuration screen (see section "Alarm Defaults")

• Edit Movement Alarms - This option should be ticked if members of the user group are
allowed to edit the default movement alarm settings

• View Tank Alarms - This option should be ticked if members of the user group are
allowed to view the default tank alarm settings (see section "Tank Alarms") on the
Default Alarm Configuration screen

• Edit Tank Alarms - This option should be ticked if members of the user group are
allowed to edit the default tank alarm settings

• Add Tank Alarm Override - This option should be ticked if members of the user group
are allowed to create new tank override alarm settings

• Remove Tank Alarm Override - This option should be ticked if members of the user
group are allowed to remove tank override alarm settings

• View Timed Activity Alarms - This option should be ticked if members of the user
group are allowed to view the default timed activity alarm settings on the Default Alarm
Configuration screen

• Edit Timed Activity Alarms - This option should be ticked if members of the user group
are allowed to edit the default timed activity alarm settings

• Add Timed Activity Alarm Override - This option should be ticked if members of the
user group are allowed to create new timed activity override alarm settings

• Remove Timed Activity Alarm Override - This option should be ticked if members of
the user group are allowed to remove timed activity override alarm settings

13.1.4  Movement Classes
• View - This option should be ticked if members of the user group are allowed to view the

Movement Classes screen (see section "Movement Classes")
• Edit - This option should be ticked if members of the user group are allowed to edit

movement class details
• Add - This option should be ticked if members of the user group are allowed to create

new movement classes
• Remove - This option should be ticked if members of the user group are allowed to

remove movement classes

13.1.5  Movement Subject Alarms
• View - This option should be ticked if members of the user group are allowed to view the

alarm settings for movement subjects
• Edit - This option should be ticked if members of the user group are allowed to edit the

alarm settings for movement subjects

13.1.6  Movement Tank Activity Alarms
• View - This option should be ticked if members of the user group are allowed to view the

alarm settings for timed activities on movements
• Edit - This option should be ticked if members of the user group are allowed to edit the

alarm settings for timed activities on movements

13.1.7  Movement Tank Alarms
• View - This option should be ticked if members of the user group are allowed to view the

alarm settings for movement tanks
• Edit - This option should be ticked if members of the user group are allowed to edit the

alarm settings for movement tanks
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13.1.8  Timed Activities
• View - This option should be ticked if members of the user group are allowed to view the

Timed Activities screen (see section "Timed Activities")
• Edit - This option should be ticked if members of the user group are allowed to edit

timed activity details
• Add - This option should be ticked if members of the user group are allowed to create

new timed activities.
• Remove - This option should be ticked if members of the user group are allowed to

remove timed activities

13.2  Operation
• Movement Certificate

• Modify - Permits a user to modify the movement certificate data, for instance to add
independent dips from a third party

• View - Permits a user to view and print the movement certificate
• Simple - Options applying to the simple movements. If using the full movements

package it is recommended to disable these options
• Add Tank - This option should be ticked if members of the user group are allowed to

add extra tanks to movements
• Add Timed Activity - This option should be ticked if members of the user group are

allowed to add extra timed activities to movements
• Amend Planned Figures - This option should be ticked if members of the user group are

allowed to amend planned figures
• Cancel - This option should be ticked if members of the user group are allowed to cancel

movements
• Close - This option should be ticked if members of the user group are allowed to close

movements
• Configure Views - This option should be ticked if members of the user group are

allowed to configure views (see section "Maintain View")
• Edit Movement Header - This option should be ticked if members of the user group are

allowed to edit the header details of movements
• Movement Log - This option should be ticked if members of the user group are allowed

to view movement logs
• Open - This option should be ticked if members of the user group are allowed to open

movements
• Plan - This option should be ticked if members of the user group are allowed to plan

movements
• Suspend - This option should be ticked if members of the user group are allowed to

suspend movements
• View - This option should be ticked if members of the user group are allowed to view

movements
• View Historical Movements - This option should be ticked if members of the user group

are allowed to view the Historical Movements screen
• View History - This option should be ticked if members of the user group are allowed to

view the history of movements.
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13.2.1  Tank Limits
• Plan Above Max Operating Figures - This option should be ticked if members of the

user group are allowed to plan movements that would take tanks above their maximum
operating level or volume

• Plan Below Min Operating Figures - This option should be ticked if members of the
user group are allowed to plan movements that would take tanks below their minimum
operating level or volume

• Open Above Max Operating Figures - This option should be ticked if members of the
user group are allowed to open movements that would take tanks above their maximum
operating level or volume

• Open Below Min Operating Figures - This option should be ticked if members of the
user group are allowed to open movements that would take tanks below their minimum
operating level or volume

14  Glossary
Load Product is taken from a tank to a place outside the site.

Receipt Product arrives from outside the site to be stored in a tank on site.

Transfer Product is moved between two or more storage vessels on the site.

ETF Estimated time to finish.

Actual Volume The volume transferred since the movement was opened.

Planned Volume The volume to be transferred by the movement.

Subject The movement subject is the tank or transport which will receive or export the whole of the
planned volume.
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